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โปรแกรม MetaTrader 4เป็นโปรแกรมที่ใช้สำ�หรับการซื้อขายสินค้าอนุพันธ์ ในตลาด TFEX ซึ่งได้รับความนิยม

สูงสุด นอกจากนี้ตัวโปรแกรมยังถูกพัฒนามาอย่างเหมาะสม ทำ�ให้เป็นโปรแกรมท่ีมีความสามารถมากมายและ 

ใช้งานได้ง่ายอีกด้วย

          ประโยชน์การใช้งานโปรแกรม MetaTrader 4

                 - ใช้งานง่ายและมีหน้าตาของโปรแกรมที่ไม่ซับซ้อน (ทำ�ให้ผู้ใช้งานไม่สับสน)

                 - สามารถปรับแต่งมุมมองและใส่กลุ่มสีสำ�หรับกราฟต่างๆ ได้อย่างอิสระ

                    - สามารถเลือกการแสดงผลกราฟได้ถึง 3 ประเภทหลักคือ Bar Chart, Candlesticks และLine Chart

                 - เลือกแสดงผลกราฟได้ 9 ช่วงเวลา(Timeframe)

                 - รองรับอินดิเคเตอร์ (Indicator) ที่มาพร้อมกับโปรแกรมจำ�นวนมากกว่า 50 รูปแบบ

                   (ช่วยให้นักลงทุนวิเคราะห์ทิศทาง ราคาได้ง่ายขึ้น)

                 - สามารถเพิ่มอินดิเคเตอร์หลายชนิดได้ในกราฟเดียวกัน

                 - สามารถแสดงผลราคาได้หลายคู่พร้อมกัน

                 - รองรับโปรแกรมเทรดแบบอัตโนมัติEA (Expert Advisor)

- สำ�หรับ Windows

1. ดาวน์โหลดตัวติดตั้งโปรแกรมได้ที่ http://www.toptrader.co.th/download/

2. ตัวอย่างติดตั้งโปรแกรม ตามlinkนี้:http://goo.gl/hjG1Za
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การเปลี่ยนรหัสผ่าน

การ Login
1. วิธีการ login เข้าสู่ระบบให้คุณไปที่ เมนู File แล้วเลือก Login กรอกชื่อบัญชีผู้ใช้ออนไลน์และรหัสผ่าน  

    ส่วน Server ให้เลือกเป็นTopTrader Co-Liveจากนั้นกด Login เพื่อเข้าสู่ระบบ

1. เข้าไปที่เมนู Tools -> Options

2. คลิกที่แท็บServer และกดปุ่ม Change

3. ที่ช่อง Current password ให้ใส่รหัส

ผ่านปัจจุบัน, ช่อง New password ใส่

รหัสผ่านที่ต้องการเปลี่ยน (รหัสผ่านจะ

ต้องมีความยาวอย่างน้อย 5 ตัว และ 2 

ใน 3 จะต้องมีตัวอักษรตัวเล็ก, ตัวใหญ่, 

และตัวเลขรวมอยู่ด้วย), ช่อง Confirm 

ใส่รหัสผ่านใหม่ยืนยันอีกครั้ง เสร็จแล้ว

กด OK

2. ถ ้า Log in ผ ่านเร ียบร ้อยแล ้ว ตรงม ุมล ่างขวา

จะแสดงเครื่องหมายดังรูป ถ้า Log in ไม่ผ่านจะแสดงคำ�ว่า  

No Connection หรือ Invalid Account หรือข้อความ Error 

อื่นๆ
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เมื่อเข้าสู่ระบบแล้ว คุณสามารถเพิ่ม

กราฟที่คุณต้องการได้โดย ไปที่เมนู 

File แล้วเลือก New Chart จากนั้น

เลือกสินค้าที่คุณต้องการได้

การเข้าใช้งานโปรแกรม MetaTrader 4
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ต่อจากนั้นเราจะมาศึกษารายละเอียดภายในโปรแกรมและวิธีการเทรดกัน ซึ่งตัวโปรแกรมสามารถแบ่งได้เป็น  

5 ส่วนหลักๆตามรูป

1.กดเคร่ืองหมายบวกท่ีอยู่ด้านบนซ้ายและ

เลือกสินค้าที่ต้องการถ้าไม่เจอสินค้าที่ต้องการ 

ให้เข้าไปคลิกขวาที่หน้าต่าง Market Watch 

และเลือกที่ Show All

การเปิดกราฟ

ส่วนที่ 1 จะเป็น Menu Bar และ Tool Bar มีเครื่องมือสำ�หรับการวิเคราะห์กราฟ

ส่วนที่ 2 Market watch แสดงรายละเอียดของสินค้าต่างๆ

ส่วนที่ 3 Navigator เป็นส่วนที่แสดง ชื่อและเลขบัญชีการลงทุนของเรา

                   - Account คือเลขบัญชีออนไลน์ของคุณและชื่อของคุณ

                   - Indicator คือเครื่องมือช่วยในการวิเคราะห์ ที่มากับระบบของโปรแกรม MT4

                   - Custom Indicator คือรายการ indicator ที่add เข้ามาเพิ่มนอกเหนือจากที่ระบบมีไว้ให้แล้ว

	       หากเราต้องการเพิ่ม indicator ใน MT4 ให้ copy ไฟล์ไปวางที่ 

                     C:\Program Files\MetaTrader4 – TopTrader\MQL4\Indicators

                   - Expert Advisors (EA) คือโปรแกรมที่ทำ�รายการซื้อขายให้อัตโนมัติ หากเราต้องการเพิ่ม

                     Expert Advisor ใน MT4 ให้ copy ไฟล์ไปวางที่ 

                     C:\Program Files\MetaTrader4 - Top Trader\MQL4\Experts

ส่วนที่ 4 คือกราฟสินค้าที่คุณทำ�การเปิดขึ้นมา

ส่วนที่ 5 เป็นรายละเอียดเกี่ยวกับการซื้อขายสินค้าของคุณและเงินทุนของคุณ



2. กราฟของสินค้าจะแสดงขึ้นมาดังรูป เวลาในกราฟจะเป็นเวลาที่ Server ของตลาดนั้นๆ 4.ที่แท็บColors สามารถเปลี่ยนสีของกราฟได้

5.ที่แท็บCommon สามารถเปลี่ยนรูปแบบของกราฟรวมถึงให้แสดงหรือซ่อนเส้นต่างๆได้

3. สามารถปรับแต่งรูปแบบของกราฟ เช่น สี, ประเภทของกราฟ, เส้นต่างๆ โดยคลิกขวาที่กราฟและเลือก  

     Properties หรือกด F8
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Toolbar
ที่ Toolbar ก็จะมีไอคอนต่างๆให้ใช้งานดังนี้ (เรียงลำ�ดับตามกรอบสีแดงที่วงไว้จากบนลงล่าง) 1.4 Data Window - หน้าต่างดูข้อมูลราคาเปิด, 

ปิด, สูงสุด, ต่ำ�สุด, Volume ของกราฟ ให้นำ�

เมาส์ไปวางไว้ท่ีตำ�แหน่งท่ีต้องการดูรายละเอียดใน

กราฟ

1.5 Navigator - หน้าต่างแสดงรายชื่อ, 

Indicator, EA, Script

1.6 Terminal - หน้าต่างแสดงออเดอร์ที่กำ�ลังเปิดอยู่, ประวัติการเทรด, 

Mailbox, Log ของ EA, รายละเอียดการ Log in รวมถึง Error ต่างๆ

1.Standardbar
1.1 New chart – การเปิดหน้าต่างกราฟใหม่

1.2 Profile –หน้าต่างสินค้าที่เรากำ�หนดไว้

1.3 Market Watch – หน้าต่างดูราคาของสินค้าต่างๆแบบเรียลไทม์
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1.7 Strategy Tester - หน้าต่างไว้สำ�หรับการเทสEA(รายละเอียดอยู่ในเรื่องการทดสอบระบบ)

1.8  ปุ่มเปิดออเดอร์ซื้อขาย

1.9  ปุ่มเปิด MetaEditor (ใช้เขียน EA) 

1.10 ปุ่มเปิด/ปิดการใช้งาน EA (ถ้าการเปิดใช้งานปุ่มจะเป็นสีเขียว ถ้าปิดการใช้งานปุ่มจะเป็นสีแดง)

1. คลิกที่ปุ่ม Indicators ทางด้านบนและเลือก Indicator ที่ต้องการเพิ่ม

2. เสร็จแล้วจะมีหน้าต่างเพื่อเซตค่าต่างๆสำ�หรับ Indicator ตัวอย่างแสดงการเพิ่ม Moving Average

2. Chartbar
2.1 ปุ่มแสดงรูปแบบกราฟเป็นแบบแท่ง

2.2 ปุ่มแสดงรูปแบบกราฟเป็นแบบแท่งเทียน

2.3 ปุ่มแสดงรูปแบบกราฟเป็นแบบเส้น

2.4 ปุ่มขยายกราฟ

2.5 ปุ่มย่อกราฟ

2.6 ปุ่ม Auto Scroll ให้กราฟขยับไปทางซ้ายเรื่อยๆเมื่อราคามีการอัพเดท

2.7 ปุ่ม Chart Shift คือให้กราฟขยับเลื่อนไปทางด้านซ้าย

2.8 ปุ่ม Indicator ไว้เพิ่ม Indicator ในกราฟ

2.9 ปุ่ม Period ไว้เลือกช่วงเวลา (Timeframe) ต่างๆ

2.10 ปุ่ม Templates ไว้เซฟรูปแบบกราฟเก็บไว้

3. Linestudiesbar
3.1 ปุ่มเลือกรูปแบบเมาส์เป็น Cursor เพื่อแสดงในกราฟ

3.2 ปุ่มเลือกรูปแบบเมาส์เป็น Crosshairเพื่อแสดงในกราฟ

3.3 เอาไว้ลากเส้น, เขียนข้อความต่างๆบนกราฟ, และ Indicator Fibonacci

4. Periodicitybar
4.1 เลือกช่วงเวลา (Timeframe) ต่างๆ

การเพิ่ม Indicator
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3. Indicatorก็จะแสดงในกราฟดังรูป

4. ถ้าต้องการแก้ค่าต่างๆของ Indicator ให้ดับเบิ้ลคลิกที่ Indicator ก็จะมีหน้าต่างเซตค่าต่างๆแสดงขึ้นมา  

     เหมือนในข้อที่ 2

5. ถ้าต้องการลบ ให้กด (Ctrl + i) จะแสดงรายชื่อ Indicator ทั้งหมดที่อยู่ในกราฟ ให้คลิกชื่อ Indicator 

    ที่ต้องการลบ แล้วกด Delete

1. หลังจากคุณได้ทำ�ความรู้จักกับโปรแกรม MetaTrader 4 แล้ว หากคุณต้องการซื้อขายให้คุณกด F9 หรือ 

    คลิกขวาที่กราฟ> Trading > New Order จะปรากฏBox แสดงรายละเอียดเกี่ยวกับการซื้อขายขึ้นมา

2. จะมีหน้าต่างแสดงขึ้นมาดังรูป

การเปิด/ปิดออเดอร์

2.1 Symbol –สินค้าที่ต้องการซื้อขาย

2.2 Volume - จำ�นวนสัญญาที่ต้องการเทรด

2.3 Stop Loss - ราคาที่จะให้ปิดออเดอร์อัตโนมัติเมื่อขาดทุน

2.4 Take Profit - ราคาที่จะให้ปิดออเดอร์อัตโนมัติเมื่อกำ�ไร

2.5 Comment - สามารถใส่ Comment สำ�หรับออเดอร์ที่จะเปิด

2.6 Type - Instant Execution / Market Execution*คือเปิดออเดอร์ทันที, Pending Order 

      คือเปิดออเดอร์  แบบ Pending (รอให้ราคามาถึงจุดที่เราต้องการถึงจะทำ�การเปิดออเดอร์) 

      *หมายเหตุถ้าใน Server Live จะเป็น Market Execution

2.7 Sell - เปิดออเดอร์ขาย

2.8 Buy - เปิดออเดอร์ซื้อ

การใช้คำ�สั่งซื้อ-ขายในโปรแกรมMetaTrader 4

6. สามารถลง Indicator อื่นๆเพิ่มเติมได้โดยให้เข้าไปที่เมนู File -> Open data folder แล้วนำ�ไฟล์ Indicator    

    (ไฟล์นามสกุล mq4 หรือ ex4) ใส่ไว้ที่โฟลเดอร์

    C:\Program Files\MetaTrader 4 - Top Trader\MQL4\Indicators

    เสร็จแล้ว Restart MT4, ทำ�ตามข้อ 1 ก็จะเห็นชื่อ Indicator ที่เพิ่มไว้อยู่ในหัวข้อ Custom



3. ถ้าเลือกการเปิดออเดอร์เป็นแบบ Pending หน้าต่างจะเปลี่ยนเป็นดังรูป การเปิดออเดอร์แบบนั้เป็นการตั้งเปิด

ออเดอร์ทิ้งไว้ในกรณีที่ราคาที่เราต้องการซื้อหรือขายยังไม่เกิดขึ้น เมื่อราคาปัจจุบันมาถึงราคาที่เราตั้งไว้ 

ออเดอร์ก็จะเปิดให้อัตโนมัติ
3.1.2 Sell Limit คือทำ�การขายเมื่อราคาปัจจุบันอยู่ต่ำ�กว่าราคาที่เราจะขาย

3.1.3 Buy Stop คือทำ�การซื้อเมื่อราคาปัจจุบันอยู่ต่ำ�กว่าราคาที่เราจะซื้อ

ในส่วน Pending Order จะมีค่าต่างๆให้เลือกดังนี้

3.1 Type order 

ตัวอย่าง
3.1.1Buy Limit คือทำ�การซื้อเมื่อราคาปัจจุบันอยู่สูงกว่าราคาที่เราจะซื้อ
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3.1.4 Sell Stop คือทำ�การขายเมื่อราคาปัจจุบันอยู่สูงกว่าราคาที่เราจะขาย

3.2 at price - ใส่ราคาที่เราต้องการซื้อขาย

3.3 Place - ทำ�การเปิดออเดอร์Pending

3.4 Expiry –เวลาหมดอายุของออเดอร์แต่ละออเดอร์ ถ้าเลยเวลาที่ระบุออเดอร์นั้นๆจะถูกยกเลิกโดยอัตโนมัติ

5. ถ้าต้องการปิดออเดอร์ ให้ดับเบิ้ลคลิกที่รายละเอียดของออเดอร์ จะมีหน้าต่างแสดงขึ้นมาดังรูป เลือก Type 

เป็น Instant Execution และกดปุ่ม Close เพื่อปิดออเดอร์

4. ถ้าทำ�การเปิดออเดอร์แล้วจะเห็นรายละเอียดออเดอร์ที่หน้าต่าง Terminal ด้านล่างดังรูป

4.1   Order - หมายเลขออเดอร์

4.2   Time - เวลาที่ทำ�การเปิดออเดอร์ (เวลาใน Server)

4.3   Type - ประเภทออเดอร์ (ซื้อหรือขาย)

4.4   Size –จำ�นวนสัญญา

4.5   Symbol –สินค้า

4.6   Price - ราคาที่ทำ�การเปิดออเดอร์

4.7   S/L - ราคา Stop Loss (หมายเหตุ 0 คือไม่ได้ทำ�การเซต)

4.8   T/P - ราคา Target Profit (หมายเหตุ 0 คือไม่ได้ทำ�การเซต)

4.9   Price - ราคาปัจจุบัน

4.10 Commission - ค่าคอมมิชชั่น

4.11 Profit - กำ�ไร/ขาดทุน

4.12 Balance - ยอดเงินที่ยังไม่รวมกำ�ไรหรือขาดทุนของออเดอร์ที่กำ�ลังเปิด

4.13 Equity - ยอดเงินที่รวมกำ�ไรหรือขาดทุนของออเดอร์ทั้งหมดที่กำ�ลังเปิดอยู่

4.14 Margin - จำ�นวน Margin ทั้งหมดที่ใช้ไปในการเปิดออเดอร์

4.15  Free Margin - จำ�นวน Margin ที่เหลือเพื่อไว้สำ�หรับเปิดออเดอร์

4.16 Margin Level - มีค่าเท่ากับ (Volume*intial_margin/100) ถ้าลดเหลือน้อยต่ำ�กว่าค่า Margin level 

ตรงออเดอร์จะเป็นสีแดงๆเตือนขึ้นมา ถ้าต่ำ�กว่า Stop level ออเดอร์ก็จะถูกปิดให้โดยอัตโนมัติ ซึ่งแต่ละบัญช ี

ก็จะมีระดับ Margin level และ Stop Level ที่แตกต่างกัน

6. ถ้าต้องการแก้ไขออเดอร์ เช่น Stop Loss หรือ Take Profit ให้ดับเบิ้ลคลิกที่รายละเอียดของออเดอร์ จะม ี

หน้าต่างแสดงขึ้นมาดังรูป เลือก Type เป็น Modify Order แก้ไขรายละเอียดดามต้องการ และกดปุ่ม Modify 

เพื่อแก้ไขออเดอร์

Tips: การใช้งาน One click Trading สามารติดตามได้ตามลิงค์นี้ http://goo.gl/86SoiD
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7. ถ้าทำ�การปิดออเดอร์แล้ว รายละเอียดออเดอร์ก็จะย้ายไปอยู่ในแท็บ Account History ดังรูป

8. ที่แท็บAccount History สามารถคลิกขวาเพื่อเลือกออฟชั่นต่างๆได้ดังนี้

9.  ที่แท็บJournal จะแสดงรายละเอียดคำ�สั่งที่เราทำ�การเทรดทั้งหมด รวมถึง Error ต่างๆ

8.1  All History - ให้แสดงประวัติการเทรดทั้งหมด 

      (โดย Default จะแสดงประวัติการเทรดของเดือนปัจจุบัน)

8.2  Last 3 Months - ให้แสดงประวัติการเทรดย้อนหลัง 3 เดือน

8.3  Last Month - ให้แสดงประวัติการเทรดของเดือน  ปัจจุบัน

8.4 Custom Period - สามารถเลือกช่วงเวลาที่จะให้แสดง   

       ประวัติการเทรดได้

8.5 Save as Report - คือการ Export ประวัติการเทรด 

       ออกมาเป็นไฟล์

8.6  Save as Detailed Report - คือการ Export  

       ประวัติการเทรดแบบละเอียดออกมาเป็นไฟล์

8.7  Commissions - ให้แสดง/ซ่อนคอลัมน์ Commissions

8.8  Taxes - ให้แสดง/ซ่อนคอลัมน์ taxes

8.9  Comments - ให้แสดง/ซ่อนคอลัมน์ Comments

8.10  Auto Arrange - จัดขนาดของคอลัมน์อัตโนมัติ

8.11  Grid - ให้แสดง/ซ่อนเส้นแบ่งคอลัมน์

7.1  Order - หมายเลขออเดอร์

7.2  Time - เวลาที่ทำ�การเปิดออเดอร์ (เวลาใน Server)

7.3  Type - ประเภทออเดอร์ (ซื้อหรือขาย)

7.4  Size - จำ�นวนสัญญา

7.5  Symbol –สินค้า

7.6  Price - ราคาที่ทำ�การเปิดออเดอร์

7.7  S/L - ราคา Stop Loss 

       (หมายเหตุ 0 คือไม่ได้ทำ�การเซต)

7.8  T/P - ราคา Target Profit 

       (หมายเหตุ 0 คือไม่ได้ทำ�การเซต)

7.9  Time - เวลาที่ทำ�การปิดออเดอร์ 

       (เวลาใน Server)

7.10  Price - ราคาที่ทำ�การปิดออเดอร์

7.11  Commission - ค่าคอมมิชชั่น

7.12  Profit - กำ�ไร/ขาดทุน

ลูกศรซ้าย = เลื่อนกราฟไปทางซ้าย

ลูกศรขวา = เลื่อนกราฟไปทางขวา

Page Up = เลื่อนกราฟไปทางซ้ายแบบรวดเร็ว

Page Down = เลื่อนกราฟไปทางขวาแบบรวดเร็ว

Home = เลื่อนกราฟกลับไปในอดีตที่โปรแกรมสามารถแสดงให้ดูได้

End = เลื่อนกราฟกลับมาที่ปัจจุบัน

ปุ่มลบ (-)=ซูมกราฟอออก

ปุ่มบวก (+) =ซูมกราฟเข้า

Delete = ลบเครื่องมืดที่ขีดไว้ออกจากหน้าจอ

ปุ่ม Backspace = ลบเครื่องมือที่ลากไว้ล่าสุดออกไป

ปุ่ม Enter = เปิดหน้าต่างค้นหากราฟ

ปุ่ม ESC = ปิดหน้าต่างค้นหากราฟ

ปุ่มฟังชั่นต่างๆ (Function Keys)

F1 = เปิดคู่มือการใช้งาน MT4 เบื้องต้น (ภาษาอังกฤษ)

F2 = เปิดดูข้อมูลของกราฟย้อนหลัง

F4 = เปิด “Meta editor” (แก้ไขข้อมูลของโปรแกรมใน drive c)

F8 = เปิดหน้าต่าง “Properties” ขึ้นมา

F9 = เปิดหน้าต่าง New Order

F10 = เปิดหน้าต่าง Popup Price (จะเป็นตัวเลขเล็กๆวิ่งไปวิ่งมา) ขึ้นมา

F11 = ทำ�ใจกราฟกลายเป็น Full Screen (ขยายเต็มจอ)

F12 = เลื่อนหน้าจอกลับไปทางซ้าย

ปุ่ม Shift + ปุ่มฟังชั่น 

Shift + F12 = ปุ่มเลื่อนราคาย้อนกลับทีละหนึ่งแท่งเทียน

Shift + F5 = เปลี่ยนกราฟที่เรียงอยู่ส่วนของ profile ของเรา

ปุ่ม Alt + ปุ่มลัด

Alt + 1 = เปลี่ยนรูปแบบของกราฟเป็นรูปแบบของ Bar Chart

Alt + 2 = เปลี่ยนรูปแบบของกราฟเป็นรูปแบบ Candlestick Chart

Alt + 3 = เปลี่ยนรูปแบบของกราฟเป็นรูปแบบ Line Chart (กราฟเส้น)

Alt + W = เรียกหน้าต่างช่วยในการจัดการกราฟปัจจุบันที่ใช้อยู่ออกมา
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การติดตั้งและรัน Expert Advisor (EA)

1. ให้เข้าไปที่เมนู File -> Open data folder แล้วใส่ไฟล์ EA ที่โฟลเดอร์ 

C:\Program Files\MetaTrader 4 - Top Trader\MQL4\Experts

ส่วนไฟล์ Indicator ใส่ไว้ที่โฟลเดอร์ C:\Program Files\MetaTrader 4 - Top Trader\MQL4\Indicators

2.  คลิกปุ่ม Expert Advisors ใน Toolbar ให้เป็นสีเขียวดังรูป

3. จะเห็นชื ่อ EA ที ่ห ัวข้อ Expert Advisors  

ในหน้าต่าง Navigator ดังรูป ให้คลิกที่ชื่อ EA แล้ว

ลากใส่ในกราฟ

4. จะมีหน้าต่างแสดงขึ้นมาเพื่อตั้งค่าดังรูป

Alt + F4 = ปุ่มออกจากโปรแกรม

Alt + Backspace = เรียกเอาเครื่องมือที่ลบไปล่าสุดกลับคืน

ปุ่ม Ctrl + ปุ่มลัด

Ctrl + A = ปรับขนาดของหน้าจออินดิเคเตอร์ให้กลับมาอยู่ในรูปร่างปกติ (ในกรณีที่มีอินดิเคเตอร์ในหน้าจอ)

Ctrl + B = เรียกหน้าต่าง “จัดการเครื่องมือ (Object List)”ขึ้นมา

Ctrl + C = ก๊อบบี้ตัวอักษร หรือ คำ�ใน MT4

Ctrl + D = เรียกหน้าต่าง Data Window ออกมา

Ctrl + E = เรียกใช้ Expert Advisor (EA)

Ctrl + F = เรียกใช้เครื่องมือ “Cross Hair”

Ctrl + G = เรียกใช้หรือไม่ใช้ Grid (ตาราง)

Ctrl + H = เรียกดู OHLC ( Open, High, Low, Close) ของวัน

Ctrl + I = เรียกหน้าต่าง “จัดการอินดิเคเตอร์(Indicator List)” ขึ้นมา

Ctrl + L = เรียก Volume ของราคาให้ขึ้นมาแสดงผลบนหน้าจอ

Ctrl + M = เรียกหน้าต่าง Market Watch ออกมา

Ctrl + N = เรียกหน้าต่าง Navigator ออกมา

Ctrl + O = เรียกหน้าต่าง Option หรือ Setup ออกมา 

Ctrl + P = ปรินท์กราฟออกมา (ในกรณีที่ต้องการปรินท์กราฟออกมาดูข้างนอก)

Ctrl + R = เรียกหน้าต่าง Tester ออกมา

Ctrl + S = เซฟกราฟที่ใช้เทรดเอาไว้ซึ่งจะออกมาในรูปแบบของไฟล์นามสกุล “CSV”, “PRN”, “HTM”;

Ctrl + T = เรียกหน้าต่าง Terminal ออกมา

Ctrl + W หรือ Ctrl + F4 = ปิดหน้าต่างกราฟที่ใช้อยู่ในปัจจุบัน

Ctrl + Y = แสดงหรือซ่อนเส้นแบ่งวัน Period Separator)

Ctrl + Z = เรียกเอาเครื่องมือที่ลบไปล่าสุดกลับคืน

Ctrl + ปุ่มฟังชั่น

Ctrl + F5 = เปลี่ยนกราฟที่ได้ตั้งค่าไว้ใน profile ของเรา

Ctrl + F6 = เปลี่ยนหน้าต่างของกราฟที่เราใช้อยู่ ณ ปัจจุบันเป็นอันถัดไป



4.1   Only Long - ให้ EA เปิดออเดอร์ซื้อเท่านั้น

4.2   Only Short - ให้ EA เปิดออเดอร์ขายเท่านั้น

4.3   Long & Short - ให้ EA เปิดออเดอร์ทั้งซื้อและขาย

4.4   Enable alerts - เปิด/ปิดการแจ้งเตือน

4.5   Disable alert once hit - ปิดการแจ้งเตือนเมื่อมีการแจ้งเตือนครั้งแรกมาแล้ว

4.6   Allow live trading - ให้ EA เปิดออเดอร์ในบัญชีเทรดจริงได้หรือไม่

4.7   Ask manual confirmation - ถ้า EA ต้องการเปิดออเดอร์ ให้เราต้องทำ�การยืนยันอีกหรือไม่

4.8   Allow DLL imports - อนุญาตให้ EA มีการเรียกใช้ DLL หรือไม่

4.9   Confirm DLL function calls - ให้มีการยืนยันทุกครั้งเมื่อมีการเรียกใช้ฟังก์ชั่นใน DLL หรือไม่

4.10 Allow import of external experts - อนุญาตให้มีการเรียกใช้ฟังก์ชั่นใน EA ตัวอื่นหรือไม่

หมายเหตุ โดยทั่วไปจะติ๊กที่ช่อง Long & Short ,Enable alerts ,Allow live trading ,Allow DLL imports 

,Allow import of external experts

5. ที่แท็บInputs ก็จะเป็นการเซตค่าพารามิเตอร์ต่างๆที่ใช้ใน EA ซึ่ง EA แต่ละตัวก็จะมีการตั้งค่าที่แตกต่างกัน

Expert Advisor - ให้เลือกรายชื่อ EA ที่จะทำ�การทดสอบ

Symbol - ให้เลือกสินค้าที่จะทำ�การทดสอบ

Period - ระยะเวลาของกราฟ

Model - รูปแบบที่ใช้ทดสอบ

Use date - ใช้เลือกช่องเวลาในการทดสอบ

Visual mode - ใช้แสดงการทำ�งานในรูปแบบกราฟฟิกคือโปรแกรมจะวาดกราฟแสดงในช่วงเวลาที่ทำ�การ

ทดสอบเลย

Expert properties - ใช้ปรับแต่งรูปแบบการทดสอบ สามารถปรับเปลี่ยนจำ�นวนเงินและหน่วยของเงินที่ใช้

ทดสอบรูปแบบการเปิด

ออเดอร์ และใช้ปรับเปลี่ยนค่าของ EA ที่สามารถกำ�หนดค่าเริ่มต้นได้

หมายเหต ุที่หน่วยค่าเงินให้เปลี่ยนเป็น THB โดยสามารถพิมพ์ได้เลย

6. ถ้าติดตั้งเสร็จเรียบร้อยก็จะแสดงชื่อ EA และรูปหน้ายิ้มอยู่ด้านบนขวามือของกราฟดังรูป

คู่มือการใช้งาน
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การทดสอบระบบ (BackTest)

Symbol properties - จะแสดงข้อมูลของสินค้าที่เราเลือกให้ทดสอบ

Open chart - ให้แสดงกราฟ

Modify expert - จะเอาไว้เปิด Code EA เพื่อทำ�การแก้ไข

Start - ใช้เริ่มทำ�การทดสอบ

หมายเหต ุวันที่ในเครื่องคอมพิวเตอร์ ต้องเปลี่ยนจากพุทธศักราชเป็น คริสต์ศักราช       
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Email&Notifications
คือการตั้งเตือนเมื่อมีการสั่งคำ�สั่งใดๆใน MT4 โดยทำ�การตั้งค่าได้ดังนี้

E-mail
1. ให้เข้าไปที่เมนู Tools -> Options -> Email

เลือกที่ช่อง Enable

2. ตั้งค่าSMTP Server  เช่นGmailใช้ smtp.gmail.com:465เป็นต้น

SMTP login - ชื่อ Email

SMTP password – รหัสผ่านที่ใช้ใน Email

From – ชื่อผู้ส่ง

To – ชื่อผู้รับ

3. กด OK เพื่อเริ่มการใช้งาน

Notifications
การตั้งเตือนผ่าน Smart phone หรือ Tablet โดยผ่าน Application MT4 

โดยขั้นตอนดังต่อไปนี้ (Android, IOS)

1. ให้เข้าไปที่เมนู Tools -> Options ->Notifications
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เลือกที่ช่อง Enable

ทางฝั่ง Smart phone หรือ Tablet (Android ,iOS)
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นำ�ค่า MY ID ไปใส่ในช่อง MetaQuotes ID ของโปรแกรม MT4 (PC)
เมื่อมีการส่งคำ�สั่งจะแสดงบน Smart phone หรือ Tablet(Android ,iOS) จะแสดงภาพดังนี้





ช่ือหนงัสือ   คู่มือการใชง้าน MetaTrader4 

ช่ือผูแ้ต่ง/รวบรวม   ทอ๊ปเทรดเดอร์ 

ฉบบัพิมพท่ี์ 1       พิมพค์ร้ังแรก   สิงหาคม 2557                            

สงวนสิทธ์ิตามประราชบญัญติัลิขสิทธ์ิ 

                          ห้ามท าซ ้า ดัดแปลง หรือน าไปเผยแพร่ ไม่ว่าส่วนหน่ึงส่วนใดของหนังสือคู่มือเล่มนี ้ 

นอกจากจะได้รับอนุญาตเป็นลายลกัษณ์อกัษรจากบริษัท ท๊อปเทรดเดอร์ จ ากดั 

จดัท ารูปเล่ม จดัพมิพ ์ 

บริษทั   ทอ๊ปเทรดเดอร์ 

ท่ีอยู ่69/9 ชั้นท่ี 5  ถนนสุขาภิบาล 2 ประเวศ เขตประเวศ กรุงเทพมหานคร 10250 

โทรศพัท ์  02-021-0777     

ท่ีอยูอี่เมลล ์  info@toptrader.co.th 

พิมพท่ี์  บริษทั   ทอ๊ปเทรดเดอร์ 

 

 


